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OVERVIEW 

Times has been specifically designed so that you can keep a day-to-day record of time 
spent with clients. Times provides an accurate and efficient method of time keeping 
which can be used for invoicing or exporting to other systems.  This software is ideal 
for professionals who run multiple projects for a range of clients and charge by the 
hour. 
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ARCHITECTURE 

The Times application has three components as shown below.  
 
1. Palm application 
2. PC Access database 
3. Synchronisation conduit 
 

Desktop System

Palm 1

Palm 2

Palm HotSync®

1

3

2

 
Time sheet entries can be made either on the Palm, the PC or both. When the Palm is 
synchronised using Hotsync manager the new or changed entries will be transferred 
between each system. 
 
Times is designed to be multi user, i.e. one PC may be used to synchronise multiple 
Palm devices. Alternatively many PC’s can sync to the same Times database using a 
shared network drive. This allows a number of users to enter time sheet data remotely 
on their Palms and synchronise to a central database. Consolidated invoicing and 
reporting may then be performed from the centralised PC Access database. 
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SYSTEM REQUIREMENTS 

PC Times requires Windows 95, 98, ME, XP, 2000 or NT. In addition, Microsoft Access 
97, 2000 or above is required to run the Times Access database.  
Note: If you do not have Access installed then you can extract the data in to Excel 
format. See the FAQ section. Hotsync manager must also be installed and configured.  
 

PALM Times is compatible with all devices running Palm OS 3.0 and above. This includes 
the Palm III, Palm IIIx, Palm V, Palm Vx, Palm VII, Tungsten, IBM WorkPad, 
Handspring, Clie, Trio and many more. To determine your OS version click the Info 
menu item from the Home page on your Palm. When the info page is shown click the 
Version option. Your OS version will be displayed at the top of the screen. 
 

 
 
Times is not compatible with the original Pilot 1000 or Pilot 5000. 
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INSTALLATION 

IF YOU ARE UPGRADING PLEASE GOTO THE UPGRADE SECTION 
 

REQUIREMENTS Prior to installing Times the PC must have the following software installed: 
1. Palm HotSync® manager with a cradle connecting to the Palm. 
2. If the PC Access database is required, MS Access 97 or above must be installed 

or you can download the free runtime version from 
http://www.comit.com.au/public/TimesAppRunTime.zip 

 
Note: The Times application can be installed without the PC database and 
Synchronisation conduit. In such cases only HotSync® is required for the install. If 
you are installing the PC database and you do not have Access97 installed then you 
may require additional system files. Please see the FAQ section. 
 

EXTRACTING THE 
SETUP FILES 

This step is required for all installations. 
1. Download the TimesSetupFull.zip file to a temporary directory. 
2. Unzip TimesSetupFull.zip to a temporary directory 
3. In explorer locate the directory where you extracted the files. 
 
PC Install 
This step is only required if you wish to use the PC database to synchronise Times 
with your PDA. Repeat this step for each PC that is to access the Times database or 
be used to sync with a Times PDA. Note: You must be logged on with administrative 
privileges to install the PC software 
 
1. Locate the Setup.exe file (or TimesInstall.bat on the minimal install) and run it. 

a. If you receive a warning regarding missing DAO files please go to 
http://www.comit.com.au/Support.htm and download and install 
DAOTest.  

2. The program will prompt for an installation directory. We recommend using the 
default.  

 
If you choose an alternative please make a note of the directory as you will be 
required to enter this into the synchronisation conduit. 

WARNING 

 
3. Click Unzip to install the database files. 
 
The PC Database Application is now installed. You may start the application by 
double clicking on the TimesApp.mdb file in the installation directory or using the 
Times Icon in the Program Start menu. 
 
PDA Install 
This step must be repeated for each PDA that requires Times to be installed. 
 
1. In Explorer locate the Times.prc file in the installation directory. 
2. Double click on the Times.prc file. 
3. You may be prompted to select the user of the palm to install to, if so select the 

appropriate user and click ‘OK’. 
4. Click ‘Done’ when the Install Tool window appears. 
 
The Times application will now be installed to your PDA when you next synchronise. 
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Conduit Configuration 
The Times Conduit is a small application which interfaces into Hotsync to 
synchronise the Times records during the HotSync process. This application is 
installed when you run TimesInstall.bat or Setup.exe. After installing you will notice 
a TimesCond entry under the Hotsync Custom menu option. If you installed the 
Times.mdb file to the default location you may skip the next step. 
 
The conduit must point to the Times.mdb file to be used during synchronisation. Do 
not point it to the TimesApp.mdb file.  
 
To change the location of the Times.mdb file open up the Hotsync Custom dialog by 
right clicking on the Hotsync icon and selecting Custom. Click on the TimesCond 
entry and press Change. Click the ellipse button next to the Times DB path and select 
the Times.mdb file from your install location. 
 

 
Press OK to save your changes. 
 
Multi User Install 
Times may be configured for multiple users in a number of different ways. Two 
standard methods are outlined below 
 

MULTIPLE USERS VIA A 
SINGLE PC 

Many PDA’s can be synced to the same PC using the standard Hotsync install. Each 
PDA must have a unique Hotsync User ID to ensure each is synched correctly. To 
configure Times on a single PC for multiple users perform the following: 
 

1. Perform a standard PC install of Times 
2. Install Times to each PDA 
3. Set-up the Times Users list via the TimesApp 
4. Set the Times User ID on each PDA to one in the Times User List 
5. Enter data via each PDA and perform a sync for each PDA 
6. All data should now by consolidated in the same Times.mdb 

 
If each PDA is to sync via a separate PC then the Times.mdb can be placed on a 
shared network drive accessible via each PC. To configure Times for a distributed 
install perform the following: 

MULTIPLE USERS VIA 
SHARED NETWORK 

1. Perform a standard PC install of Times on each PC 
2. Install Times to each PDA 
3. Copy a Times.mdb file to a shared network drive. 
4. Delete all other copies of the Times.mdb file for each PC 
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5. Configure the TimesCond to point to the Shared copy of Times.mdb 
6. Re-link the tables in each TimesApp to point to the shared copy of 

Times.mdb (do not use a shared copy of TimesApp) 
7. Set-up the Times Users list via the TimesApp 
8. Set the Times User ID on each PDA to one in the Times User List 
9. Enter data via each PDA and perform a sync for each PDA 
10. All data should now by consolidated in the same Times.mdb 
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UPGRADE 

If you already have a previous version of Times installed then please CAREFULLY 
follow the instructions below to upgrade your current version. Note: This upgrade 
replaces TimesApp.mdb and updates Times.mdb (if installed). If you have made any 
changes to theses files then you may need to redo these.  
 
Once upgraded you can not go back to an earlier version of Times without removing 
Times from each PDA. 
 
New Serial Key 
Users upgrading from a version of Times prior to V2 will require a new serial key. 
Existing V2.x users do not require a new key. 
 
When purchasing the upgrade you will be required to supply your Hotsync User 
name to generate your upgrade key. Note: The user name is case sensitive so please 
ensure you enter it carefully. 
 
After receiving your Upgrade key and entering it into your PDA you will be provided 
with your full serial key. Please ensure you record this for future reference as you will 
need it to reinstall. 
 
Palm Upgrade Only 
If you are using Times V1.1 or above and have not installed the PC components and 
are not synchronising Times to the Times.mdb database, then you can simply upgrade 
the Times PDA only. To do so double click on the Times.prc file and install to your 
PDA in the usual manner. 
 
If you are running Times V1 or below then you must perform a full system upgrade. 
 
Full system upgrade 
If you are using the Times PC components (Times.mdb, TimesApp.mdb or 
TimesCond) you must follow the following procedure to upgrade. 
 
The update procedure restructures your Times.mdb database by modifying field 
types, sizes and relations. If you have modified existing tables then this update may 
fail. Custom tables which you have added will remain unchanged. During the update 
procedure a backup of the Times.mdb file will be created, however as a precaution we 
recommend you create your own separate backup. Due to a change in the key 
structure of the Activity Override rates table all existing Activity Override Rate 
records will be deleted during the upgrade. 

WARNING 

 
PREREQUISITES 1. This update procedure can only be completed if you are using the Times PC 

Hotsync conduit. If you have not set up Times to sync with your PC then you 
MUST do so first before performing this update. 

2. If upgrading a multi user install of Times please ensure all users are logged 
out of the system and all PDA’s are upgraded at the same time. 

3. The Times User ID and upgrade registration code (if required) for each PDA. 
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1. Perform a Hotsync to ensure your PC and PDA data are in sync. INSTALL 
2. Test the data on your PC to ensure it is complete and accurate. If you do not 

have Access on your PC then please download DBExport or follow the Can I 
User Excel details in the FAQ to extract your data to Excel. Only when you 
have checked your data should you proceed to the next step. 

3. Backup your PC database files (Times.mdb and TimesApp.mdb). 
4. In Explorer locate and double click on the new Times.prc file. 
5. You may be prompted to select the user of the palm to install to, if so select 

the appropriate user and click ‘OK’. 
6. Click ‘Done’ when the Install Tool window appears. 
7. Perform a Hotsync – this will install Times to your PDA. 
8. Open Times on your PDA and enter your upgrade serial key if required and 

click Register. IMPORTANT Record the new serial key provided. 
9. Check your Times UserID in the Preferences form. It must be the same name 

used previously to ensure all your data is transferred correctly. 
10. Locate the Setup.exe (or TimesUpgrade.bat in the minimal install) file and 

run it. 
a. If you do not have VB6 runtime components installed a message will 

be displayed. Please go to http://www.comit.com.au/support.htm and 
download and install DAOTest. Then repeat step 10. 

11. When the Times.mdb has been updated you may be prompted to unzip files to 
a directory. Please ensure you enter the directory where you originally 
installed the TimesApp.mdb file. Click unzip and close. 

12. Right click on the Hotsync icon and select Custom, TimesCond and Change 
13. Select Desktop Overwrites Handheld then OK and Done. 
14. Perform another Hotsync. This will restore all your data to your PDA 

 
Times is now installed. Please check your data.  
 
Note: You may need to set up your Times User list on your PC after upgrading. See 
the Times PC Database manual for more details. 
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STARTING TIMES 

Once Times is installed on your Palm a new Icon will appear as below. 
 

 or    depending on your screen resolution. 
 
Click on this icon to start Times on your Palm. 
 
If after synchronising your Palm you cannot see the icon, try selecting the “All” 
category from the top right hand side of the screen. If the icon is still not displayed 
then the application has not been installed correctly. Please repeat the Palm Install 
procedure again. 

TIP 

  
 

REGISTRATION Times is a licensed application. To purchase please go to www.palmgear.com and 
type Times in the search field. Once you have paid the small licence fee you will 
receive your serial key in your order confirmation email. When registering you will 
be required to supply the registration code (or name) displayed in the middle of 
the form when you start the application. This (Emulator in the case below) will be 
used to create your serial key. If you do not supply this code then we can not create 
your serial key. Note: the registration code is case sensitive. 
 
 

TRIAL You may use the Times application for a trial period to assess its performance. Whilst 
in trial mode the application is fully functional though the number of entries and days 
have been limited. Once this limit is reached no more records can be entered or 
edited. To start the trial click on the Register Later button shown below. Note: Whilst 
in trial mode the Register form will appear each time you start the application. 
 
 

 Registration Form 
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GETTING STARTED 

OVERVIEW Let us firstly get familiar with the Main form and feature buttons on the screen, as this 
will help us to understand how to create our first time entry.  
 
 1. Current Record and Count    
 

2. Invoiced 
e

6. Break time 

Times Main Form 

25 A
3. Entry time 
 
1. This displays the current record number and the total number of r

In this particular example, we are looking at record 3955 out of a 
records. 

2. A ticked box represents an invoiced times record, i.e. this times re
invoiced to the client. Invoicing can only be done through the PC

3. The Date, Start and End time and duration for this time sheet entr
4. A tick box that specifies that this time entry is non chargeable. 
5. Override charge rate to use for this Times entry 
6. The Break time indicates a non chargeable or break during the tim
7. The triangles represent drop down lists. When clicked a list of po

will appear for you to choose from. 
8. Notes or details regarding the current time sheet entry. 
9. These arrows are used to move through entries. Alternatively use 

down buttons on the organiser. 
10. The Goto button allows you to navigate directly to a different set

may be time based or client based depending on the current sort o
11. The Cancel button cancels any changes made to the current recor
12. The New button creates a new blank Times record. Navigating pa

will also create a new blank record. 
 

ugust 2004  Pag
5. Override Rate

4. Non Chargeabl
7. Popup Lists 

8. Notes 

9. Navigation 

ecords entered. 
total of 5805 

cord has been 
. 
y. 

e sheet entry. 
ssible selections 

the page up and 

 of records. This 
rder.  
d. 
st the last record 
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MENUS Within Times there are number of menus that can be accessed by clicking on the 

menu icon in the bottom left hand corner. These menus provide access to other forms 
and functions within Times.   
 

 
 
The menus shown above are from the main form. Sub sets of these menus are 
available on other forms. The functionality of each menu item is described later in 
this document. 
 

USER ID IMPORTANT. Each Times application requires a unique User ID in order to 
synchronise data with a PC. When using multiple Palm devices with a single PC 
database, the user ID also determines which records get transferred to the Palm. YOU 
MUST SET THE USER ID BEFORE ENTERING ANY RECORDS. THE 
TIMES USER ID IS INDEPENDENT OF YOUR HOTSYNC USER NAME 
AND REGISTRATION CODE. To set the User ID click the Preferences menu item 
under the Options menu. Set the User ID and click exit. 
 

 
 

When entering Times information on the PC please ensure you use the same 
User ID, otherwise your data will not be transferred to the PDA. 
 

AUTO NEW If you select Auto New a new record will be created when you navigate past the last 
record. Otherwise a message will be displayed. 
 

DECIMAL HRS Decimal hours determines whether durations are displayed in hours and minutes, or 
decimal hours. I.e. 1hr 30m or 1.5 
 

INVOICED RECORDS Once a Times record has been invoiced it should not be modified. Times give you the 
option of Locking, Unlocking or Prompting when an invoiced record is about to be 
modified. 

INTERVAL When creating a new Times records the Start and End time will default to the nearest 
interval specified. The interval is also used for increments and decrements of existing 
entries.  
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ENTERING DATES & TIMES 

Dates and times are easily entered using the custom Date and Time entry forms as 
shown below. To enter a date simple click on the date field and a calendar will 
appear. When you select the required date the Date field on the Time Sheet will be 
updated. 
 

Click on the Date field 
to display a calendar 

Similarly if you click on either the Start Time or End Time fields a time selector 
form will appear.  

Click on the Time fields 
to display a time selector 

  
When entering times on the time selector form, first click on Start Time and set the 
required time. Then click on End time and select the required time. If you change the 
start time the end time will be adjusted by the same amount.  
 
Alternatively you can use the Time short cut buttons  to set the Start or End Time 
to the current time. 

Click on the Hours fields to 
display a duration selector 

  
After you have selected the start and end time the hours field will be automatically 
updated. If you tap on the Hours field you can manually enter the required duration. 
Note: This will rest the End Time accordingly. 
 

25 August 2004  Page: 15 of 39  



Times User Documentation 

SELECTING CLIENTS AND JOBS 

Times allows you to maintain a list of clients and jobs related to these clients. Each 
Times record may have one client and job associated to it. 
 

CLIENT SELECTION To associate a Times record to a client simply click on the drop down list arrow next 
to Client. A list similar to the one below will be displayed.  
 

 
 
If there are more clients than can appear in the initial list, up and down arrows appear 
to allow you to scroll through the list. 
 
When you select the required client the Times record will be updated and the Jobs list 
filtered to show only jobs for this client. 
 
If you wish to cancel your selection simply tap in an area away from the list. TIP 
 

JOB SELECTION To select a job simply click the drop down list arrow next to Job. All jobs associated 
with this client will be displayed as below. Selecting a job from the list will update 
the Times record accordingly. 
 

 
 
If no jobs have been defined for this client then no list will appear. 
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Adding Clients & Jobs 
 
Select the Edit Jobs menu item under the Tools menu to enter new Clients and Jobs. 
The Job List form below will be displayed. 

Enter/Edit Job 
Details Form 

Click on a Job 
record or click New 

Job List Form 

  
To create a new job, click on New. This will display the Enter/Edit Jobs Details 
form above. If the client already exists, click on the drop down list arrow next to 
Client and a listing of all clients will appear for you to choose from. If however you 
wish to enter the name of a new client, click Add. This will display the form below. 

 

 

Enter Client Details Form 

 
Now type in your new client, which can be no more than 20 characters. Enter a 
default rate and description as necessary, then save. This will bring you back to the 
Enter/Edit Jobs Details form. 
 
Select the required Client for the new job. The Job No is a 10 character alpha field 
which you can use to identify your jobs. If you require more details then please enter 
them in the Description field. Please note that Job No’s must be unique for the Client. 
 

Active Jobs The active flag determines which Jobs are currently open and can have new Time 
entries placed against them. Jobs not active will not show up in the Times main form 
but will still be available when reporting and using the Times Summary screens. 
Typically you would set a job as not active once it has been completed. 
 
Next is the description field. This field can store any job specific info you require and 
will be displayed on the main form against each entry. Once you have entered your 
description press Save.  
 
To edit a job description, simply click on the particular job in the Jobs List form. 
Please note that you cannot change the Client of a job. You can however edit the 
Client name by clicking Edit next to the client.  
 
If you create a Job with the incorrect Client, simply delete the Job record and 
recreate it. 

TIP 
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SELECTING ACTIVITIES 

Times allows you to maintain a list of Activities which may be associated with each 
Times record. Activities are independent of Jobs and Clients.  
 

ACTIVITY SELECTION To associate a Times record to an activity simply click on the drop down list arrow 
next to Activity. A list similar to the one below will be displayed.  
 

 
 

If there are more Activities than can appear in the initial list, up and down arrows 
appear to allow you to scroll through the list. 
 
If you wish to cancel your selection simply tap in an area away from the list. TIP 
 
Adding Activities 
 
Activities may be added, edited or deleted at any time. To modify the list of activities 
click the Edit Activities menu item in the Tools menu, the following screen will be 
displayed. 

 
By selecting an Activity to edit the details, or clicking new to create a new Activity, 
the Activity Details form will be displayed. 
 

 
 

Note: Editing or deleting any existing activity does not update any Times records. 
Hourly rates can be applied to an activity. See the Rates Calculation section for more 
details. When complete click Save or Cancel to return to the Main form. 
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ACTIVITY OVERRIDE RATES 

Activity Override Rates can be used to determine a particular rate to use for a specific 
Client, Job and Activity combination. This rate will override any general rates that 
may have been entered separately against the Client, Job or Activity. It will not 
override rates entered directly on the Times record. See the Rate Calculation section 
for more details. 
 
To create an Activity Override Rate select the Edit Override Rates menu option on the 
Tools menu to display the form below. This displays all the existing override rates 
entered. 
 

 
 
To add a new rate click the New button, or select the required rate to edit. This will 
display the form below 
 

 
 
Enter the required Client, Job, Activity and rate to use and click Save to record the 
details or Cancel to discard 
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RATE CALCULATION 

Rates in Times can be specified against the following items: 
 

1. Directly on the Times Entry using the Times Override Rate (O/R) 
2. Against specific Client, Job and Activity combinations using the Activity 

Override Rates 
3. Against specific Activities (overriding Client and Job rates) 
4. Against Jobs 
5. Against Clients 
6. Against Activities (not overriding Client and Job rates) 

 
When calculating the hourly rate each time entry is compared against the 
corresponding Client, Job, Activity and Activity Override records to determine the 
appropriate rate to use. The order of preference is based upon the order shown above. 
i.e. if a rate is specified on the Times entry, use it, otherwise check for Activity 
Override rates, Activity Rates, Job rates etc. until a rate is found. This permits generic 
rates to be specified against Activities and/or Clients along with specific rates against 
Jobs and individual Times entries. 
 
A typical configuration for the rates could be a general rate for Travel specified 
against an Activity and set to override Client. There may also be separate rates 
specified against the Client and Job for all other entries. These could be setup as 
shown below: 
 
Activities     
Activity Overrides Client Rate   
Travel Yes 75   
Meetings No     
Documentation No     
Support No 90   
     
Clients     
Client   Rate   
Client A   100   
Client B   150   
Client C       
     
Jobs     
Client Job Rate   
Client A Job 1 200   
Client A Job 2     
Client B Job 1 50   
Client B Job 2     
     
Time Entries     
Client Job Activity Hrs Applied Rate 
Client A Job 1 Travel 1 75
Client A Job 1 Meetings 1 200
Client A Job 2 Meetings 1 100
Client B Job 1 Travel 1 75
Client B Job 1 Meetings 1 50
Client B Job 2 Meetings 1 150
Client C   Support 1 90
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Note that the Applied Rate shown above is determined from the rate tables based on 
the order of preference specified.  
 

TIP To correctly specify your rates perform the following: 
 

1. To setup the rates first create your required Client, Job and Activity records 
in Times.  

2. Determine how you would normally derive the applied rate to use, i.e. is it 
Client based, Client and Job or just Activity.  

3. Specify the normal rates against the appropriate records.  
4. Determine how you will record override rates, i.e. if you use Clients as the 

normal rates, you can use Client Jobs for specific override rates. If you use 
Activities for normal rates you can use Client and or Client Jobs for specific 
override rates. 

5. Create the required override rate records based on your override method. 
Note for one off overrides your can simply enter the rate directly onto the 
Times entry. 

6. Enter some sample data into Times and test the rates by using the Calc Hours 
and Summary form 

 
Note you can update and create new rate records at any time and these will be 
reflected against all uninvoiced Times entries. 
 
Rates will typically be updated over time. Therefore when an entry is invoiced Times 
records the current rate derived against the Times record. This locks in the rate which 
is used in preference to any other rate that may be derived from the current rate tables. 
Thus rate changes after an entry has been invoiced will not effect the dollar amount 
for the Times entry. 

Invoiced Rates 

 
If you invoice a Times entry you will be given the option to update the applied rate 
against an entry. This will then be reflected in future calculations. 
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VIEW INVOICES 

View Invoices gives you a summary of all your Times records that have been 
invoiced. To open this form use the View Invoices menu item under the Tools menu.  
 

Invoices Form 

 
 

This form displays information such as the date (the date of the first Times entry 
included in this invoice), invoice number, client, total amount invoiced and total 
amount paid. Rows highlighted in red indicate invoices with outstanding payments. 
Those in green indicated over payments. Use the navigation controls or scroll bar to 
navigate through the entries. To return to the main form click on the Exit button. 
 
 
You can review the detail behind each invoice by clicking on a record in the View 
Invoices form. Doing so will display the form below. 

Invoice Detail Form 

 

 
 

This form details the hours, rate and period pertaining to the charges for this client on 
this invoice. Note: An invoice may be made up from multiple clients and thus you 
can scroll through the detail records using either the page up/down buttons or the 
navigation controls. 
 
You can not use this form to create invoices. 
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CALCULATING HOURS 

You may often be asked to provide a summary of the hours spent on a particular 
client or job. Times provides an easy way to quickly calculate your hours based on 
various filter criteria. To calculate your hours click on the Calc Hours menu item 
under the Tools menu. This will display the Select Filter form below.  

 
Select Filter Form 

Clear the current Client 
and/or Job selections 

There are three alternatives when calculating hours: 
1. By Date range only 
2. By Date range and Client only 
3. By Date range, Client and Job 

 
Along with these you can also specify to only include invoiced, non invoiced or all 
Times records. 
 
Below are the steps you would use to enter a typical calculation. 
1. First select the required date range. Tapping on the Start or End dates will display 

a calendar to assist the selection. Alternatively use the date selection list to 
specify pre set periods, eg. This week, Last month etc. 

2. If a client filter is required press the drop down list arrow next to Client and 
select the required client from the list. 

3. If a job filter is required press the drop down list arrow next to Job and select the 
required job from the list. Note only jobs for the current Client will be displayed. 

4. Select the require Invoice status, Invoiced, Not invoiced or All. 
5. Tick the Subtract Breaks check box to remove break hours from the total. 
6. Click on the Calc button to calculate the hours. 
 
You can repeat this step as often as required for different date ranges, clients or jobs. 
Clicking on the C buttons clears the current client and/or job selections. 
 
To calculate the amount Times must locate the appropriate rate for each record. With 
a large number of records this can take a few seconds. If you do not require the 
amount to be calculated uncheck the Amt check box to speed up the process. 

TIP 

 
When you have a large number of Times records tick the Sort option.Using the sort 
option will first sort the Times records in an order optimised for the current filter 
calculation. This will significantly speed up subsequent calculations assuming similar 
filter criteria.   

TIP 

 
Eg Your first calculation is based on a date range and a specific client. Using the 
Sort option will sort the Times records into client, date order before summing the 
hours.  When subsequent filters are applied for different clients, instead of analysing 
each record in the database, the application can go directly to a specific client record 
and total up hours for that client.  Note: If the filter criteria is changed i.e. Inclusion 
of jobs, then the sort will have to be reapplied.     

25 August 2004  Page: 23 of 39  



Times User Documentation 

Summary View 
 
 Once you have specified a filter you can click the View button to display a summary 
view of the selected Times records.  

 
The summary form is divided in to two parts; a description of the filter at the top, and 
a summary list of the records. To scroll through the summary list use the up and down 
arrows on the right of the list. 
 
You can change the summary view by selecting a different option from the drop 
down list at the bottom of the form.  

 
This will recalculate the summary values and redisplay the list. 

Summary View Form 

 
To change the filter simply click exit. This will return you to the Select Times Filter 
form where you can modify your filter. 
 

EXPORT Time Summary details can be exported to the Memo pad by clicking on the Export 
button. Note: Due to the size limitation of the Memo records, multiple Memo records 
may be created to store the Summary export data. 
 

PURGING RECORDS Times records can be purged using the Select Times Filter form. Simply select the 
required filter for the records you wish to delete and use the Purge Selected Record 
menu item. 

 
 
Once records have been purged they will also be removed from the PC and cannot be 
recovered. 
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TIMES LIST 

This form presents a list of all Times records and can be opened by clicking on the 
Times List menu item under the Tools menu.  

 
Times List Form 

 
 
Use the scroll bar or navigation buttons to scroll through the list. To display a 
particular record click required record to display it in the Times main form. 
 
Records can be sorted by Job, Client or Date by using the menu functions.  
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WEEK VIEW 

This form displays a graphical view of your entries for the entire week. To open this 
view select the Week View menu item under the Tools menu. 

WEEK VIEW FORM 

 
Hours are displayed across the screen from left to right and days from top to bottom. 
Each bar represents one Times entry. The total hours for each day are displayed on 
the right of the form, with the total for the week displayed at the bottom. 
 
Where entries overlap the entry is drawn half height and in a hashed or red pattern is 
shown as above. This quickly highlights entries that may have been entered 
incorrectly. Similarly Breaks are displayed in a hashed or green pattern as displayed 
above. Break hours can be included or excluded from the total hours by using the 
Breaks tick box. 
 
The Week View form provides three methods to navigate around your data; Zoom, 
Hours scroll and Weeks scroll. 
 

ZOOM The Zoom function allows you to increase or decrease the interval displayed across 
the form from 5 minutes intervals to 24 hours. To Zoom in press the I icon next to the  

 
GoTo button. Each time you press this button the display interval will decrease to 
show you more detail. Similarly press the O icon to Zoom out. 

 
HOURS SCROLL When there are Times entries starting before or after the current displayed period the 

Left and Right scroll buttons will appear at the bottom of the form. Pressing these 
buttons will scroll the display to the left or right by one time interval. 
 

WEEKLY VIEW To scroll between weeks simply press the left or right scroll buttons at the top of the 
form. This will display the next or previous week in the current view and update the 
week number accordingly. 
 

VIEW ENTRY To view a Times entry simply click on the require bar to display the entry details. The 
selected bar will be highlighted before jumping to the main form. 

25 August 2004  Page: 26 of 39  



Times User Documentation 

SORTING 

When reviewing Times entries it is often necessary to navigate between records in 
different orders. I.e. To review what you did on a particular day you would require 
the records in date order. Alternatively to review what you have done for a particular 
client you would require the records in client order. 
 
To facilitate this Times records can be sorted in three ways: 
1. Date order 
2. Client, Date order 
3. Client, Job, Date order 
 
To sort the records use the sort menu commands under the Options menu on the 
Times main form and List form. Whist the records are being sorted a message will 
appear on the screen as below. 
 

 
 

Note: If you have a large number of records (1000 +), sorting may take a few 
seconds. 
 
Once the sort is complete the first record will be displayed. Use the GOTO button to 
navigate to the required entry. 
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GOTO 

It is often necessary to navigate directly to a particular record or group of records. 
One method is to use the List form to scroll to the required record and then display it. 
The Goto button provides an alternative method. 
 
The Goto button displays either a calendar or a list of clients depending on the current 
sort order. If the sort order is by date then the calendar is displayed, otherwise the 
client list is shown.  
 

 
Selecting a date or a client will navigate the current Times record to the first 
occurrence of this selection. If no occurrence is found then the next record after the 
selection is displayed. If the date selection is before or after all Times records then the 
first or last records is displayed respectively.  
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QUICK START 

When creating a time entry always remember the following sequence:  
 
ENSURE YOU HAVE ENTERED YOUR USER ID IN THE PREFERENCES 
FORM BEFORE ENTERING ANY DATA 
 
1. Set up the Clients (if required) 
2. Set up the Jobs (if required) 
3. Set up the Tasks (if required) 
4. Set up the Activities  (if required) 
5. Enter your time records 
 
A new entry will default to the current date. To change this date, click on the Start 
Date field. A calendar will appear so that a specific date can be chosen.  Start Time 
and End Time default to current time. To change, click on the time fields. Further 
times will then be displayed for you to choose from. Total hours spent on this job will 
be calculated automatically. So that this job is billed to the right client, click on the 
triangle next to Client. This will give you a list of all the clients. Now click on the 
triangle next to Job. A list of job numbers with their descriptions will be listed to 
choose from. Further notes can be written on the lines provided. You are now ready to 
save this time sheet. The entry is automatically saved when you exit times, use a 
menu item or create a new record. 
 
Note: New clients and jobs must be entered under Edit Jobs before a Time Sheet can 
use them. 
 
Time entries can be deleted using the Record/Delete menu function TIP 
 

25 August 2004  Page: 29 of 39  



Times User Documentation 

SUPPORT 

Times has been thoroughly tested on multiple Palm devices. If in the unlikely event 
you experience a problem please first ensure you have followed the installation and 
setup instructions and reviewed the FAQ section and material on our website 
http://www.comit.com.au/support.htm.  
 
If the problem persists please email all bugs and support related enquires to  

support@comit.com.au 
 

and include Times Support in the email header.  
 
To assist us we will require the following information: 

1. Registration No or serial key, purchase date and contact details 
2. Palm OS version 
3. Your PC windows version 
4. A detailed description of the problem. If it is bug related an example of the 

operations performed which caused the problem. 
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FAQ 

To use the PC Application you must have a version of Access >= 
97 installed. Users without Access can download and installed 
the free runtime version from 
www.comit.com.au/public/TimesAppRunTime.zip 

WHAT IF I DON’T HAVE 
ACCESS INSTALLED? 

 
1. First off, have you installed the Times Conduit? It should 
be installed when you run the TimesInstall.bat file or the 
Setup.exe. To check right click on your Hotsync icon and select 
Custom. If installed you should see a TimesCond entry. If it is 
not there then run Conduit Reinstall from the Times Start menu.  

WHY DOES HOTSYNC 
CONSISTENTLY FAIL? 

 
2. Is the Conduit configured to look at the right database? 
From the Hotsync custom menu select TimesCond and click change. 
Ensure the path at the bottom of the form points to the 
Times.mdb file and that the file is actually there. 
 
3. If you have installed the PC database without Access97 
installed then you may be missing some system files on your PC. 
Please go to www.comit.com.au/support.htm and download MFC.zip 
and DAOTest.zip. Unzip MFC.zip and run Setup, you may need to 
restart after installing. Then unzip DAOTest and run Setup. The 
conduit should now work. 
 
4. Did you configure the UserID before entering any times 
records? This is usually the reason why the Synch fails. Any 
Times records created before you entered your User ID will have 
Times ID's against them. When you Synch with the PC only the 
records with the same ID as that in the preferences form will 
be copied across. To resolve the problem see the Why Are there 
more records on My Palm than PC FAQ. 
 
5. Do you enter the same User ID on the Palm as you use on the 
PC? The Times user ID is located under Options/Preferences. 
This ID determines which records get transferred between your 
PC and Palm. When entering records on the PC please ensure you 
either type in the ID correctly or select it from the list box. 
It's often useful to set the Default if you have only one user. 
 
6. Have you converted the Times.mdb database to Access 2000? If 
so the conduit is probably coming up with an Unrecognised 
Database format error. If you have already entered data the 
only way to fix this is to convert the Times.mdb file back to 
Access 97. To do this open up the Times.mdb file in Access 
2000, click Tools, Database Utilities, Convert Database, To 
Previous version. Save the database under a new name. Close 
Access and rename the Times.mdb file to something else 
(Times2000.mdb). Then rename the newly created database to 
Times.mdb, this database should now be in Access 97 format. 
 
If you have not entered any data simply reinstall the database 
using the TimesInstall.bat file. 
 
It is not necessary to convert the database in order to use it 
under 2000. You can if you wish convert the TimesApp.mdb file 
to 2000 and leave the Times.mdb in 97 format. 
 
This error received when you run DAOTest is reporting that the 
database path can not be found in your win.ini file. Possibly 
because the conduit is not working due to the database error. 
To check please open up your {windows dir}\win.ini file in note 
pad and look for an entry like TimesCond. If it is not found 
then please open right click on Hotsync, click custom, 
TimesCond, Change. Check that the correct path is specified at 

DATABASE PATH NOT 
FOUND WHILST 
RUNNING DAOTEST 
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the bottom of the form. Then rerun the DAOTest. If it fails 
again send us the screen shot. 
 
 
This is a known issue when you first install Times. The problem 
occurs when you use the PC application before any records have 
been created on the Palm and then synchronised. The PC actually 
creates a blank record which is saved in the PC database. When 
you then synchronise with the Palm this "flawed" entry gets 
transferred to the Palm as an invalid record. 

INVALID RECORD 
AFTER SYNC WITH PC 

 
To correct the problem first perform a Synch with your Palm. 
Assuming you have more than one Times entry simple delete the 
invalid record on the PC. Then perform a Desktop overwrites 
Handheld synch (one time only). This will replace all the Palm 
records with those on the PC (minus the invalid record). You 
should now no longer have an invalid record. Note you only have 
to perform this once for each new installation, and not at all 
if you enter Times records on the Palm and Synch first. 
 
Starting with Times V2.2 the Access database can be in either 
97 or 2000 format. The Times.mdb file MUST be in Access 97 or 
2000 format for the conduit to work correctly. The TimesApp.mdb 
file however can be any format. If you are using a later 
version of Access a message will appear simply telling you that 
it was created under an older version, but that won't stop it 
from running. 

HOW DO I USE TIMES 
WITH ACCESS 2000 AND 

ABOVE? 

 
It you want to convert TimesApp to your current version then 
simply close down Access (TimesApp), Start Access again by 
going to Start, Programs Microsoft Access, click cancel when 
the dialog appears. 
Then click Tools, Database Utilities, Convert Database, To 
current Access Database Version. Then browse to your 
TimesApp.mdb and click Convert. Enter a new file name for the 
converted version (say TimesApp2000) and click Save. 
 
Then close down Access and open up you new file by double 
clicking on it, this will open up the new TimesApp program 
without the message. Both the conduit and application should 
work fine.  
 
In design mode (ie. When looking at the code in debug mode) 
click the Tools menu and then references. You should have 

COMPILE ERROR 
RUNNING TIMESAPP 

 
Visual Basic for Applications 
Microsoft Access x .x Object Library 
OLE Automation 
Microsoft DAO x.xx Object Library 
Microsoft VisualBasic for Applications Extensibility 
 
If any of these are missing then there is a problem with your 
installation of Access. Please scroll down the list and there 
may be other compatible libraries available ie, Microsoft DAO 
3.5 Object Library can be replaced with Microsoft DAO 3.51 
Object Library 
 
Times uses an optimised two way synchronisation routine which 
requires complicated data manipulation. ie during any single 
sync updates, deletions and additions may have occurred on both 
the PC and the Palm. In order to process these Times uses a 
technique called double buffering where a separate copy of the 
data is maintained in the Access database. This complexity does 
lead to significant performance gains (we synchronise a 10,000+ 
record DB in less than 20 seconds) but does unfortunately mean 
that it can not easily be achieved in Excel.  

CAN I USE EXCEL 
INSTEAD OF ACCESS? 
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However, if your aim is to simply extract and use the data on 
the PC (not to update) then you can import it into Excel or any 
other ODBC compliant application. To do so open a new excel 
sheet. Click Data, Get External Data, New Database Query. This 
should open MS Query. On the Databases tab select MS Access 
Database and OK. Browse to the location of your Times.mdb file 
and open it. You will be prompted to select the data to include 
in your query, click on Times and click the right arrow button. 
Click next three times and then select return data to Excel and 
click finish. 
 
You should now see all your data entered on your Palm. If 
required you can also import the other tables. The TimesCOND 
table is the double buffer mentioned earlier. 
 
However recently we have released a free export utility 
(DBExport V1) which will take all the data from the Times (and 
ODO) database and export it to a CSV format suitable for Excel. 
You can find this utility at http://www.comit.com.au/support.htm. If 
you wish to use this utility please ensure you have MDAC2.6 
installed (see the DBExportReadme file). 
 
 
There are a number of reasons you may have different record 
counts on your Palm to the PC, some by design and some caused 
by incorrect use.  

WHY ARE THERE MORE 
RECORDS ON MY PC 

THAN MY PALM?  
Times is designed to consolidate multiple Palms to one 
database. To do so each Palm must have a unique Times User ID 
which is attached to each Times record. When you sync, only 
records with the same Palm and Times User ID’s are transferred 
to and from your PC. If either your Palm or PC User ID’s have 
been changed after entering records, when you synch you are 
only synchronizing your current User ID's records. This would 
explain why there are more records on the PC than on the Palm. 
 
If you operate your Times system with only one User you can 
verify this by either reviewing all your Times records on the 
PC and looking for different ID's or running the following 
query against your Access database: 
 
Select Distinct ID from Times 
 
This query will list all the unique ID's used against your 
records. 
 
If you have used multiple ID's then performing a Handheld 
overwrites Desktop will not fix the problem as it will only 
replace records with the same User ID as currently used on the 
Palm. To fix you must first perform a synch and ensure all 
records from your palm are correct on the PC. Then update all 
Times records on the PC to the current Palm User ID either by 
manually modifying them or running the following query: 
 
Update Times Set ID = 'Enter Your User ID here between the 
quotes' 
 
Then perform a Desktop overwrites Handheld. This will copy all 
the PC records back to the Palm with the new User ID's where 
appropriate. Your Palm and PC should now be in sync. 
 
Other causes would be where you have manually modified the User 
ID or the RecID on the PC after synching with the Palm. This 
would effectively have the same effect as changing the Palm 
User ID and cause the records not to be copied to the Palm. To 
fix follow the same procedure above. 
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If you have manually modified the TimesCond table then you will 
most likely loose sync between the data on the Palm and PC. 
Again the best way to fix this is to ensure the PC data is 
correct and perform a Desktop overwrites Handheld. 
 
Finally if there is a problem with the Times Conduit this could 
cause loss or corruption of data. Currently we are not aware of 
any such problems but you can review your Hotsync log to verify 
this. If the conduit is working correctly you should see OK 
TimesCond in your log file. Otherwise forward the log file to 
support@comit.com.au and we'll investigate. 
 
 
 

WHY ARE THERE MORE 
RECORDS ON MY PALM 

THAN MY PC? 

Have you changed your user ID on your Palm after entering 
records?. TIMES is designed to be multi user, i.e. many Palm 
devices can synch to the same Access database. This is 
facilitated by recording the User ID against each record. The 
User ID should not be changed after you have started entering 
data. If you change the user ID after entering records then you 
will only synchronise those records created with the new ID. 
 
To resolve this you can either: 
A) Change the User ID back to the original name (assuming you 
have not entered any new records with the new ID) and perform a 
Handheld overwrites Desktop. All your records should now be in 
synch. 
 
or  
 
B) Note: You will need Access or another ODBC tool to perform 
this process. First Perform a Handheld overwrites Desktop. This 
will copy all the Handheld records to the TIMECond table. If 
the User ID on the Palm is different than the ID against the 
TIMES records then these records will not be copied to the 
TIMES table and you will have to do this manually. To do so 
first delete all existing records in your TIMES table using the 
query below, replace YourID with your current TIMES User ID. 
 
DELETE FROM TIMES Where ID = “YourID” 
 
Next perform an update query on the TIMECond table to set the 
UserID to the same as that on the Palm, use the query below 
replacing YourID with your current user id (leave the quotes), 
and Your OLD ID with the previous User ID 
 
UPDATE TIMESCOND SET ID = "YourID"  
WHERE ID =”Your OLD ID” 
 
Then append all records to the TIMES table using the query 
below: 
 
INSERT INTO Times ( ID, StartDate, StartTime, RecId, EndTime, 
Hours, Client, JobNo, Task, Invoiced, Details, Activity, 
InvoiceNo, NonChargeHours, Amount, NonCharge, AppliedAmount, 
CustomNo1, CustomNo2, CustomNo3, CustomNo4, CustomNo5, 
CustomText1, CustomText2, CustomText3, CustomText4, CustomText5 
) 
SELECT TimeCond.ID, TimeCond.StartDate, TimeCond.StartTime, 
TimeCond.RecId, TimeCond.EndTime, TimeCond.Hours, 
TimeCond.Client, TimeCond.JobNo, TimeCond.Task, 
TimeCond.Invoiced, TimeCond.Details, TimeCond.Activity, 
TimeCond.InvoiceNo, TimeCond.NonChargeHours, TimeCond.Amount, 
TimeCond.NonCharge, TimeCond.AppliedAmount, TimeCond.CustomNo1, 
TimeCond.CustomNo2, TimeCond.CustomNo3, TimeCond.CustomNo4, 
TimeCond.CustomNo5, TimeCond.CustomText1, TimeCond.CustomText2, 
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TimeCond.CustomText3, TimeCond.CustomText4, 
TimeCond.CustomText5 
FROM TimeCond 
WHERE (((TimeCond.ID)="YourID")); 
 
All your records will now be in the TIMES table. Check the data 
and when satisfied make a backup of the TIMES.mdb file (just in 
case) and perform a desktop overwrites handheld synch. All your 
TIMES records should now be in sync. 
 
As long as you do not perform a Desktop overwrites Handheld 
before getting the records into the TIMES table you should not 
loose your data. 
 
 
This is not a feature of Times but can easily be achieved with 
a little SQL knowledge. Create a new query in the TimesApp.mdb 
and switch to SQL view. Paste the following code and click run. 

HOW TO CREATE AN 
ACTIVITY OVERRIDE 
RATE FOR ALL JOBS  

INSERT INTO ActivityRates (ID, Client, JobNo, Activity, Amount, 
Shared) 
SELECT [Your ID], Jobs.Client, Jobs.JobNo, [Your Activity] AS 
Activity, [Your Rate] AS Amount, 0 as Shared 
FROM Jobs 
 
When run you will be prompted to enter your User ID, activity 
and rate. The query will then append an override rate for the 
entered activity for all Client Jobs. Note: If an override rate 
already exists then you will get an error when running this, 
but the new overrides will still be appended. 
 
You have deleted a Client from your PC and also modified a Job 
for that Client on your Palm. Thus when you try to sync the 
Palm is trying to add or change a record for a client that no 
longer exits. 

YOU CAN'T ADD OR 
CHANGE A RECORD 

BECAUSE A RELATED 
RECORD IS REQUIRED 

IN TABLE 'CLIENTS'. 
 
To resolve the issue determine which system is up to date, your 
Palm or PC and then perform the appropriate sync: 
 
 Palm up to date – Handheld Overwrites Desktop 
 PC up to date – Desktop Overwrites Handheld 
 
Before you can start entering Times you must first set up at 
least one Client and Job for a new Times user. Open the Clients 
form and type in the new UserID in the User drop down list 
(over writing any existing name) after all existing Client 
entries. Next enter the client name as usual. 

HOW TO ADD A NEW 
TIMES USER IN 

TIMESAPP 

 
Open the Jobs form and select the new user from the drop down 
list. Create the new job and return to the Main form. You will 
have to refresh the main form (or close and reopen TimesApp) 
before the new user will be visible. 
 
Times is not designed to sync to more than one PC since it 
supports two way data changes. The only way to get the data on 
two pc's is to either copy the Times.mdb between PC's (the 
preferred method for backups) or set both PCs to Handheld 
Overwrites Desktop sync for Times. This will overwrite the data 
on each sync to each PC. 

SYNCING TO MORE 
THAN ONE PC 

 
To migrate Times to a new PDA you must first ensure all your 
data is backed up to your PC. Perform and sync and check Times 
App to ensure all you data is present. 

HOW DO I MOVE TIMES 
TO A NEW PDA? 

 
Next, if your new PDA is using the same Hotsync profile Times 
will automatically be installed on the next sync. After 
installing change the Times Conduit to Desktop Overwrites 
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Handheld and perform another sync. All your Times data will now 
be on your new PDA. 
 
If you are not using the same Hotsync profile then install the 
same version of Times on your new PDA either from the original 
Times.prc file or by beaming it from your old PDA. Open up 
Times and enter your registration code and set the Times User 
ID to that used on your old PDA. Set the Times Conduit to 
Desktop Overwrites Handheld and perform another sync. All your 
Times data will now be on your new PDA. 
 
A duplicate record error in the Hotsync log file means that a 
record which was created on the PDA already exists on the PC. 
This can happen if Hotsync fails during a sync, you try to sync 
two PDA’s to the same Times database using the same Times User 
ID, or you have created the same record on both the PC and PDA 
between syncs. When this happens the Times conduit will exit to 
ensure no data is corrupted in the PC database. 

DUPLICATE RECORD 
ERROR WHEN SYNCING 

 
To resolve the issue perform a Desktop Overwrites Handheld Sync 
for Times to reset the data on your PDA. Note all changes 
entered into your PDA that have not been synced will be lost. 
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LICENCE AGREEMENT 

ComIT Solutions Pty Ltd. LICENSE AGREEMENT 
 
This is a legal agreement between you and ComIT Solutions Pty Ltd. 
covering your use of Times.  Be sure to read the following agreement 
before using the software.  IF YOU DO NOT AGREE TO THE TERMS OF THIS 
AGREEMENT, DO NOT USE THE SOFTWARE AND DESTROY ALL COPIES OF IT. 
 
This ComIT End-User License Agreement ("EULA") is a legal agreement 
between you (either an individual or a single entity) and ComIT Solutions 
Pty Ltd. By installing, copying, or otherwise using Times ("the 
Software") on any computer or device, you agree to be bound by the terms 
of this EULA. If you do not agree to the terms of this EULA, you are not 
authorized to use the Software. 
 
GRANT 
 
ComIT Solutions Pty Ltd. grants you a non-exclusive license to use the 
Software. 
 
You may: 
* use the Software on any single computer or electronic device; 
* use the Software on a second device so long as only one copy is used at 
a time; 
* copy the Software for archival purposes, provided any copy must contain 
all of the original Software's proprietary notices and this license 
agreement; or 
 
You may not: 
* permit other individuals to use the Software except under the terms 
listed above; 
* permit concurrent use of the Software; 
* modify, translate, reverse engineer, decompile, disassemble or create 
derivative works based on the Software; 
* copy the Software other than as specified above; 
* rent, lease, grant a security interest in, or otherwise transfer rights 
to the Software; or 
* remove any proprietary notices or labels on the Software. 
 
WARRANTY 
 
ComIT Solutions Pty Ltd. warrants that for a period of sixty (60) days 
from the date of acquisition, the Software, if operated as directed, will 
substantially achieve the functionality described in the Documentation.  
ComIT Solutions Pty Ltd. does not warrant, however, that your use of the 
Software will be uninterrupted or that the operation of the Software will 
be error-free or secure. ComIT Solutions Pty Ltd. also warrants that the 
media containing the Software, if provided by ComIT Solutions Pty Ltd., 
is free from defects in material and workmanship and will so remain for 
sixty (60) days from the date you acquired the Software. ComIT Solutions 
Pty Ltd's sole liability for any breach of this warranty shall be, in 
ComIT Solutions Pty Ltd's sole discretion: (i) to replace your defective 
media; or (ii) to advise you how to achieve substantially the same 
functionality with the Software as described in the Documentation through 
a procedure different from that set forth in the Documentation; or (iii) 
if the above remedies are impracticable, to refund the license fee you 
paid for the Software. Repaired, corrected, or replaced Software and 
Documentation shall be covered by this limited warranty for the period 
remaining under the warranty that covered the original Software, or if 
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longer, for thirty (30) days after the date (a) of shipment to you of the 
repaired or replaced Software, or (b) ComIT Solutions advised you how to 
operate the Software so as to achieve the functionality described in the 
Documentation. Only if you inform ComIT Solutions Pty Ltd. of your 
problem with the Software during the applicable warranty period and 
provide evidence of the date you purchased a license to the Software will 
ComIT Solutions Pty Ltd. be obligated to honor this warranty. ComIT 
Solutions Pty Ltd. will use reasonable commercial efforts to repair, 
replace, advise or, for individual consumers, refund pursuant to the 
foregoing warranty within 30 days of being so notified. 
 
THIS IS A LIMITED WARRANTY AND IT IS THE ONLY WARRANTY MADE BY ComIT 
Solutions Pty Ltd. ComIT Solutions Pty Ltd. MAKES NO OTHER EXPRESS 
WARRANTY AND NO WARRANTY OF NONINFRINGEMENT OF THIRD PARTIES' RIGHTS. THE 
DURATION OF IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION, WARRANTIES 
OF MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR PURPOSE, IS LIMITED TO 
THE ABOVE LIMITED WARRANTY PERIOD; SOME JURISDICTIONS DO NOT ALLOW 
LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO LIMITATIONS MAY NOT 
APPLY TO YOU. NO ComIT SOFTARE DEALER, AGENT, OR EMPLOYEE IS AUTHORIZED 
TO MAKE ANY MODIFICATIONS, EXTENSIONS, OR ADDITIONS TO THIS WARRANTY.  
 
If any modifications are made to the Software by you during the warranty 
period; if the media is subjected to accident, abuse, or improper use; or 
if you violate the terms of this Agreement, then this warranty shall 
immediately be terminated. This warranty shall not apply if the Software 
is used on or in conjunction with hardware or software other than the 
unmodified version of hardware and software with which the software was 
designed to be used as described in the Documentation.  THIS WARRANTY 
GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT 
VARY BY JURISDICTION. 
 
DISTRIBUTION 
 
Distribution of the Software is not allowed without permission of ComIT 
Solutions Pty Ltd. 
 
You may not modify, translate, reverse engineer, decompile, disassemble 
or create derivative works based on the Software. You may not copy the 
Software other than as specified above. You may not rent, lease, grant a 
security interest in, or otherwise transfer rights to the Software. You 
may not remove any proprietary notices or labels on the Software. You 
must maintain all copyright notices on all copies of the Software.  
 
TITLE. 
 
Title, ownership rights, and intellectual property rights in the Software 
shall remain in ComIT Solutions Pty Ltd.  
 
TERMINATION. 
 
The license will terminate automatically if you fail to comply with the 
limitations described herein.  On termination, you must destroy all 
copies of the Software and Documentation. 
 
EXPORT CONTROLS. 
 
None of the Software or underlying information or technology may be 
downloaded or otherwise exported or reexported (i) into (or to a national 
or resident of) Cuba, Iraq, Libya, Yugoslavia, North Korea, Iran, Syria 
or any other country to which the U.S. has embargoed goods; or (ii) to 
anyone on the U.S. Treasury Department's list of Specially Designated 
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Nationals or the U.S. Commerce Department's Table of Denial Orders. By 
downloading or using the Software, you are agreeing to the foregoing and 
you are representing and warranting that you are not located in, under 
the control of, or a national or resident of any such country or on any 
such list. 
 
LIMITATION OF LIABILITY 
 
UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, OR 
OTHERWISE, SHALL ComIT Solutions Pty Ltd. OR ITS SUPPLIERS OR RESELLERS 
BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE 
OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES. IN NO 
EVENT WILL ComIT Solutions Pty Ltd. BE LIABLE FOR ANY DAMAGES IN EXCESS 
OF THE AMOUNT ComIT Solutions RECEIVED FROM YOU FOR A LICENSE TO THE 
SOFTWARE, EVEN IF ComIT Solutions Pty Ltd. SHALL HAVE BEEN INFORMED OF 
THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. 
THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR 
PERSONAL INJURY TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. 
FURTHERMORE, SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION 
OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND EXCLUSION 
MAY NOT APPLY TO YOU. 
 
HIGH RISK ACTIVITIES. 
 
The Software is not fault-tolerant and is not designed, manufactured or 
intended for use or resale as on-line control equipment in hazardous 
environments requiring fail-safe performance, such as in the operation of 
nuclear facilities, aircraft navigation or communication systems, air 
traffic control, direct life support machines, or weapons systems, in 
which the failure of the Software could lead directly to death, personal 
injury, or severe physical or environmental damage ("High Risk 
Activities").  ComIT Solutions Pty Ltd. and its suppliers specifically 
disclaim any express or implied warranty of fitness for High Risk 
Activities. 
   
MISCELLANEOUS. 
 
If any provision of this Agreement is held to be unenforceable, such 
provision shall be reformed only to the extent necessary to make it 
enforceable.  This Agreement shall be governed by California law (except 
for conflict of law provisions). The application the United Nations 
Convention of Contracts for the International Sale of Goods is expressly 
excluded. 
 
U.S. GOVERNMENT RESTRICTED RIGHTS.  Use, duplication or disclosure by the 
Government is subject to restrictions set forth in subparagraphs (a) 
through (d) of the Commercial Computer-Restricted Rights clause at FAR 
52.227-19 when applicable, or in subparagraph (c)(1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013, or at 
252.211-7015, or to ComIT Solutions Pty Ltd's standard commercial 
license, as applicable, and in similar clauses in the NASA FAR 
Supplement. Manufacturer is ComIT Solutions Pty Ltd, 2/765 Burwood Rd, 
East Hawthorn, 3123, Victoria, Australia. ABN 24 093 555 705. 
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